The information in this document reflects products at the date of printing. Unitronics reserves the right, subject to all applicable laws, at any time, at its sole discretion, and without notice, to discontinue or change the features, designs, materials and other specifications of its products, and to either permanently or temporarily withdraw any of the forgoing from the market.

All information in this document is provided "as is" without warranty of any kind, either expressed or implied, including but not limited to any implied warranties of merchantability, fitness for a particular purpose, or non-infringement. Unitronics assumes no responsibility for errors or omissions in the information presented in this document. In no event shall Unitronics be liable for any special, incidental, indirect or consequential damages of any kind, or any damages whatsoever arising out of or in connection with the use or performance of this information.

The tradenames, trademarks, logos and service marks presented in this document, including their design, are the property of Unitronics (1989) (R"G) Ltd. or other third parties and you are not permitted to use them without the prior written consent of Unitronics or such third party as may own them.
VisiLogic: HMI Applications
**HMI Display Editor**

Use the HMI Display Editor to create the Displays that the controller shows on its screen after the program is downloaded. When you click on HMI in the Project Explorer tree, a Display replica opens. The replica reflects the type of Vision controller you have selected in your project's Hardware Configuration.

Displays tell your operators what to do. You can have your operators log in with a password, enter setpoints and other data, and instruct the operator what to do in case of a system problem or alarm. A Display can contain both text and images. Text and images can be both fixed and/or variable. If the project is based on a touch-screen controller, you can also assign touch properties to on-screen objects.

**Variables** are inserted into a Display to:

- Show run-time values as integers
- Represent run-time values with either text, images, or bar graphs
- Show text messages that vary according to runtime conditions.

The features in the HMI editor are determined by the controller type selected in Hardware Configuration. The next image is from a project based on an Enhanced Vision controller comprising a color touch screen.
Getting Started with Displays

Text in HMI Displays
Displays can contain both fixed and Variable text. **Fixed** (constant) text does not change according to run-time conditions. **Variable** text can show run-time values, such as timer values, or display operating instructions according to system status.

Graphic Images in Displays
Simple geometric shapes can be drawn on a Display. Graphic images can be imported from the Image Library, or created with a program such as Microsoft Paint and then imported.

- Fixed graphic images
  This type of image stays on the screen and does not change until a different Display is loaded by the program.

- Variable graphic images
  Variable images change according to the value of a linked operand. Binary Image Variables are linked to bit operand status (MB, SB, I, T, O). List Image Variables are linked to integers (MI, SI, ML, SL).

Copy & Paste Displays
You can copy and paste Display elements.

1. Copy the Display element(s) or select all of the elements in a Display.
2. Paste the elements into the Display.

- or -

Select Paste from the Edit menu.

Note •

- When you paste elements into a Display, the elements paste into the same relative area in the new net. The elements 'remember' their original location. Therefore, before you paste elements into a Display that already contains elements, move any elements that occupy the same position as the paste selection.

- If you paste variables that are linked to named constant values, note that the constant's description is lost during the paste operation.

- Variables do not retain their descriptions; they are renamed as Variable 1, Variable 2, etc..

- To copy elements between projects, copy your selection from the source project, then open a target project without closing VisiLogic, either by using the New Project or Open project buttons or via these options on the Project menu. If you close VisiLogic, the selection will be lost.

Import/Export Displays

You can export displays and save them as .vld files, then import them into other projects.

Export

1. Select Export Displays from the Project menu.

2. Select the display you want to export, and click Add.

3. When you have added all of the displays you want, save them as a .vld file to the desired location.

Note •

- Displays that contain Trend variables cannot be exported

- If a Display contains variables that are linked to the String
Getting Started with Displays

Undo

VisiLogic supports up to 10 Undo/Redo actions.

The list of supported actions is shown below.

<table>
<thead>
<tr>
<th>Ladder</th>
<th>HMI</th>
<th>Project</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete ladder element</td>
<td>Delete HMI Display</td>
<td>Compile</td>
</tr>
<tr>
<td>Delete ladder net</td>
<td>Delete HMI Elements</td>
<td>Build All</td>
</tr>
<tr>
<td>Delete Comments</td>
<td>Clear HMI Display</td>
<td></td>
</tr>
<tr>
<td>Cut Ladder Elements</td>
<td>Cut HMI Element</td>
<td></td>
</tr>
<tr>
<td>Cut Ladder Net</td>
<td>Paste HMI Elements</td>
<td></td>
</tr>
<tr>
<td>Paste Ladder Element</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Paste Ladder Net</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clear Sub</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Changing Displays (Jumps)

To change between Displays, set Jumps. A Jump contains a Jump condition, which is linked to a bit operand, and a destination Display. You can also change Displays by placing a Load Display function in a Ladder net.

Setting Jumps

1. Open a Display.
2. Click on a Jump Condition field, and select an operand.

3. Click on Display field, and select a destination Display.

To edit a Jump, click the desired field and make a new selection.

**Notes**
- When an HMI keypad entry variable is active, and the Enter key is pressed on the controller keypad, SB 30 HMI Keypad Entries Completed turns ON. This can be used as a Jump condition.
- To see a list of Displays in a project together with their Display numbers, select HMI Information from the View menu.
Getting Started with Variables

**Variables**

Variables enable you to show run-time values, text, images, and bar graphs on the controller's screen in response to run-time conditions. Bit, or binary text variables, for example, display text messages on the controller's LCD screen according to the status of a bit operand.

The maximum number of variables per display depends on the Vision controller division.

- Standard Vision: supports up to 24 variables
- Enhanced Vision: supports up to 255 variables

You can also use Keypad Entry Variables to enable an operator to enter a password, or data such as setpoints from the controller's keyboard.

**Variable Editor**

When you insert a variable into a display, the Variable Editor opens, showing you the options that are relevant for that variable.

Note that for some types of variables, the type of controller selected in Hardware Configuration may determine some of the variable's properties. For example, touch-screen models enable you to assign Touch Properties to on-screen objects.

The next image shows a binary variable used in a V120 project.
The next image shows numeric variable options for touch-screen color models. These enable you to assign Touch Properties to on-screen objects, and offer options for depth and color.

<table>
<thead>
<tr>
<th>Hide</th>
<th>Causes the object/text to disappear from view</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Suspends any touch properties</td>
</tr>
<tr>
<td>Disable</td>
<td>'Greys' a button object</td>
</tr>
<tr>
<td></td>
<td>Suspends any touch properties</td>
</tr>
<tr>
<td>Marking View</td>
<td>Changes the color of the button to dark blue background, white inverse text</td>
</tr>
<tr>
<td></td>
<td>Does not affect touch properties</td>
</tr>
<tr>
<td>Keypad OK</td>
<td>Turns ON when Keypad Entry value is within legal limits</td>
</tr>
<tr>
<td></td>
<td>Turns OFF when Keypad Entry value exceeds legal limits</td>
</tr>
</tbody>
</table>

After you have inserted Variables into a display, they are shown with that display in the Project tree.
Inserting a Variable into a Display

To show variable data:

1. Click on a variable in the HMI toolbar, then click on the HMI screen and drag your cursor to create a field for the display of the variable data.

2. Release the mouse button; a dialog box opens, enabling you to define the source of the variable data.
   The next image shows a binary variable, named Switch Status, linked to MB0.
   When MB 0
   = 0, the text OFF will be displayed in the field.
   =1, the text ON will be displayed in the field.

Field: Too Small

If a field is too small to display data, a warning message is displayed at compilation and download. In addition, monochrome controllers color a field that is too small in red.
HMI Displays

About the HMI Display and Keypad

All Vision controllers offer an integrated HMI operating panel that includes an LCD screen and a keypad. The screen size, type and keypad vary. Exact specifications regarding Vision operating panels are included in the user's manuals.

'Touchscreen' controllers

There are different types of Vision touch-screen models:

<table>
<thead>
<tr>
<th>Monochrome LCD +</th>
<th>HMI function keypad and virtual keypad</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum number of displays: 255</td>
<td></td>
</tr>
<tr>
<td>Maximum number of variables per display: 24</td>
<td></td>
</tr>
</tbody>
</table>

In these models, activate the virtual keypad by turning SB 22 Enable Virtual Keypad ON. This must be done at power-up, or before entering a Display containing a keypad variable. In addition, the Keypad entry variable must be assigned a Touch Property.

<table>
<thead>
<tr>
<th>Monochrome LCD +</th>
<th>Virtual keypad only</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum number of displays: 255</td>
<td></td>
</tr>
<tr>
<td>Maximum number of variables per display: 24</td>
<td></td>
</tr>
</tbody>
</table>

In these models, the virtual keypad opens whenever the user touches a keypad entry variable that is currently displayed on the screen.
Note that to enter Information Mode, you touch the touchscreen in an area that is not occupied by a Keypad Entry variable or other screen object that has been assigned a Touch Property.

Color Touchscreen LCD+
virtual keypad only
Maximum number of displays: 1024
Maximum number of variables per display: 255

The virtual keypad functions in the same way as in monochrome models.

Inserting a Variable into a Display

To show variable data:

1. Click on a variable in the HMI toolbar, then click on the HMI screen and drag your cursor to create a field for the display of the variable data.
2. Release the mouse button; a dialog box opens, enabling you to define the source of the variable data.
   The next image shows a binary variable, named Switch Status, linked to MB0. When MB 0
   \[= 0\], the text OFF will be displayed in the field.
   \[= 1\], the text ON will be displayed in the field.

   **Field: Too Small**
   If a field is too small to display data, a warning message is displayed at compilation and download. In addition, monochrome controllers color a field that is too small in red.

   **Align, Space & Center Display Elements**
   When you align, space, and center elements, be careful not to make them the same size and align them one on top of the other. If elements are 'fused' together in this way, they cannot be separated.
Note • The HMI display uses a grid which spaces the lines 8 pixels apart. To optimize Displays and shorten the PLC cycle time, images and variables should be aligned to grid.

Global HMI Variable Bank
The Global HMI Variable bank can contain any type of HMI variable. When you open a VisiLogic project, the bank is empty. You enter variables in the bank by first creating a variable, such as a List of Images variable, and then adding it to the bank. Once a variable is in the bank, you can refer to it from any HMI Display; although you can change the linked operand, the rest of the parameters remain the same.

Why use Global Variables?
Variables take up space in the controller's Flash memory. In some applications, you may copy and paste a variable to a number of Displays, changing operand links where required. In these applications, you can save a great deal of space—and download time—by using a Global Variable, and referring to it as required. No matter how many times you refer to a Global Variable, it is a single variable.

Creating and Using Global Variables
1. Either create a new variable and then right-click on it, or
2. right-click on an existing variable, then select Set As Global Variable.
2. Enter a name for the Global Variable, then click OK.

3. The variable is now part of the Global Variable bank; in the Display, the variable now appears with an arrow, indicating that it is actually a reference to a Global Variable.

Referring to a Global Variable

Once the variable is in the bank, you can refer to it from any HMI Display.

- To insert a Global Variable
  1. Click on Insert Global Variable, then click on the display and drag the cursor; the Get Global Variable box opens.
  2. Select a variable, then click Link to open the Select Operand and Address box and link an operand to the variable; the operand address appears in the Link field
  3. Click OK, then the variable now appears with an arrow, indicating that it is actually a reference to a Global Variable.

- To link an existing variable to a global variable.
  1. Right-click the variable and select Get Global Variable; the Get Global Variable box opens.
2. Select a variable, then click Link to open the Select Operand and Address box and link an operand to the variable; the operand address appears in the Link field.

3. Click OK, then the variable now appears with an arrow, indicating that it is actually a reference to a Global Variable.

Note
- A Global variable cannot be resized.
- Deleting the last link to a Global Variable also deletes the Global Variable.

Changing Displays (Jumps)
To change between Displays, set Jumps. A Jump contains a Jump condition, which is linked to a bit operand, and a destination Display. You can also load a Display by placing a function in a Ladder net.

Setting Jumps
1. Open a Display.
2. Click on the Links & Jumps tab.
3. Click a Jump Condition field, and select an operand.

4. Click on Display field, and select a destination Display.

To edit a Jump, click the desired field and make a new selection.

**Notes**

- When an HMI keypad entry variable is active, and the Enter key is pressed on the controller keypad, SB 30 HMI Keypad Entries Completed turns ON. This can be used as a Jump condition.
- To see a list of Displays in a project together with their Display numbers, select HMI Information from the View menu.

**Calling a Subroutine via Display**

You can use a specific Display to call a specific Subroutine. This Subroutine will run during the time that the Display is shown on the controller's LCD.

**Standard Vision Controllers**
Standard Controllers Only

SBs 33 and 34 function when an HMI Display that calls a subroutine is loaded/unloaded from the display screen.

- **SB 33: Load Display with linked Call Subroutine**
  When a Display containing a Call Subroutine **starts loading**, SB 33 turns ON for a single scan cycle the first time the linked subroutine runs. Use this SB to initialize operands in the HMI subroutine.

- **SB 34 UnLoad Display with linked Call Subroutine**
  When a Display containing a Call Subroutine **starts unloading**, SB 34 turns ON for a single scan cycle the last time the linked subroutine runs. If a Display contains an ASCII String Variable, and the linked subroutine contains the Display String 'trigger' MB, reset this MB when the Display unloads by using the falling edge of SB 34.
Enhanced Vision

These controllers enable you to call three subroutines:

- One to run for a single scan when entering the Display (On Load Display)
- One to run the entire time the Display is on-screen (While Displaying)
- One to run for a single scan when exiting the Display (On Un-load Display)

In addition, you can link an MB which will be ON while the Display is shown on screen, or an XB which will change status.

To clear the subroutines and bits, right-click the relevant field.
HMI Information

To see a list of Displays in a project together with their Display numbers, select HMI Information from the View menu. To see keypad entry variable ID numbers, click the variable tab.

Elements Draw Order

This feature is available in Enhanced Vision controllers.

Except for variables, which cannot be placed one on top of another, the elements in a display are shown in layers according to the order in which they were drawn. The last element is on top of the others.

You can change this order by using the arrows in Draw Order.

In the next image, Rectangle 1 is on top of Rectangle 2.
HMI-Ladder: Load HMI Display: Functions

These Ladder functions call HMI Displays. Use these functions to initially load the Display, and then to refresh it when your application requires, as, for example, when you want to update variable display. They are located on the Ladder toolbar, under the HMI menu.

Note

Load Display functions should not be placed directly on the Ladder rail, or called by conditions that continually call the
Display when it is still loaded on the controller screen.

- You must use a transitional contact to activate a Load HMI Display or Load Last Display function.

Load HMI Display
Causes a Display to be shown on the controller's LCD as a response to a Ladder Condition.

Accessing a Load Display Target

HMI Display Loaded
This turns a linked MB ON when a specific Display begins loading.
Load Last Display
Loads the last Display loaded by the application. The function works according to LIFO list comprising the last 24 active Displays.

To see a list of HMI Displays in a project, together with the Display number, select HMI Information from the View menu.

Resizing HMI Elements
Resize an element by selecting it, then:
- Dragging the image handles.
- Clicking the Fit to Original Size (content) button.
- Clicking the Element Sizer, then selecting the desired size.
Selecting more than one element, then make them of uniform size via the Resize buttons.

HMI Element Resizing/Rotating Limitations

Elements 'grow' down, and to the right. If resizing/rotating will cause Variable elements to collide, or any element to extend beyond the boundaries of the Display, the element cannot be returned to its original size, or resized to a larger size.

Note

Fit to Original size functions differently for .bmp and for .wmf.

- .bmp: Resizes the image to the actual size of the element as it appears in the element's ToolTip; assuming that this size does not exceed the size of the display screen. If the original image exceeds the display size, the function will fail.

- .wmf/.emf: the image will be resized according to the size at which it was first inserted into the HMI application.

- 'Original size' cannot be used to resize Variable elements if the elements have differing original sizes.
About the HMI Display and Keypad

Note

Although an imported image can be resized, resizing may result in some degree of distortion. To avoid this, use images that are created to match the required size.

• Resizing text elements changes the size of the text field, but does not affect font size.

• Fit to Original Size does not affect geometric shapes that are drawn on the Display.

• Shapes that are imported are resized in proportion to their original size.

HMI SB and SIs

Keypad keys

| SB 40 | Key: # 0 |
| SB 41 | Key: # 1 |
| SB 42 | Key: # 2 |
| SB 43 | Key: # 3 |
| SB 44 | Key: # 4 |
| SB 45 | Key: # 5 |
| SB 46 | Key: # 6 |
| SB 47 | Key: # 7 |
| SB 48 | Key: # 8 |
| SB 49 | Key: # 9 |
| SB 50 | Plus/Minus |
| SB 51 | Left Arrow |
| SB 52 | Right Arrow |
| SB 53 | ENTER |
| SB 54 | Key <i> (ON when in Info mode, may also be turned ON in order to enter Info mode, via Remote Access or user program) |
| SB 55 | Up |
| SB 56 | Down |
| SB 57 | ESC |
| SB 58 | F1 |
| SB 59 | F2 |
| SB 60 | F3 |
| SB 61 | F4 |
| SB 62 | F5 |
| SB 63 | F6 |
| SB 64 | F7 |
| SB 65 | F8 |
| SB 66 | F9 |
| SB 67 | F10 |
### About the HMI Display and Keypad

#### HMI SB and SIs

<table>
<thead>
<tr>
<th>#</th>
<th>Description</th>
<th>Turned ON</th>
<th>Turned Off</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>SB 6</td>
<td>Keyboard is active</td>
<td>By OS</td>
<td>By OS</td>
<td>The touch property must be assigned to a variable. If this property is assigned, touching the variable activates it, causing it to be marked by the blinking cursor.</td>
</tr>
<tr>
<td>SB 16</td>
<td>Touchscreen Active, V280 only</td>
<td>When LCD is touched</td>
<td>When LCD is not touched</td>
<td>Enables a message to be handwritten on the touchscreen with a stylus.</td>
</tr>
<tr>
<td>SB 17</td>
<td>Enable/Disable Touch-screen indication (Message Board function) V280/290 only</td>
<td>By program</td>
<td>By program</td>
<td>Enables a message to be handwritten on the touchscreen with a stylus.</td>
</tr>
</tbody>
</table>
| SB 22 | Enable Virtual Keypad (Relevant only to Standard Vision + Touchscreen, not Enhanced) | • ON by default in Touchscreen -only models  
• By program, to enable V280 Virtual keypad | Off by default in all other models | Causes a Virtual Touchscreen to be shown on screen when the user touches a display entry variable.  
• In Touchscreen + HMI keypad models (V280), user turns ON to enable Virtual Keypad. When ON, the normal alphanumeric keypad does **not work**.  
• May be turned OFF by user. |
| SB 26 | Exiting OS Draw Mode (ON for 1 cycle after OS draw)                         | By OS                            | By OS                                | OS Draw Mode means that the controller's Operating System takes control of the LCD screen:  
• During Info Mode  
• When a Display is entered  
• When the Virtual Keypad (touch-screen models) is displayed |
| SB 27 | Disable all keypad automation (touch-screen + keyboard models only, V280)   | By program                       | By program                           | If SB 27 is ON when a Display is shown:  
• The user cannot navigate through the variables using the Enter or Right-arrow keys.  
• No Keypad Entry Variable will be marked by the blinking cursor. In this case, a variable may be activated by: |
### About the HMI Display and Keypad

**HMI SB and SIs**

**About the HMI Display and Keypad**

- Touch (V280 only) -- assuming it has been assigned the Touch property.
- By writing the variable ID # into SI 250, either via Info or Online mode.

| SB 28 LCD: controlled by OS (OS drawing on LCD) | By OS at entry to drawing mode, remains ON during the drawing task:  
- Info Mode.  
- Rises when a Display is entered.  
- When the V290 enters Virtual Keypad mode and displays the virtual keypad on the LCD. | By OS when the OS exits the drawing mode:  
- PLC exits Info Mode.  
- After a Display is entered.  
- When Virtual Keypad mode exits. | Any Ladder-drawn elements (ex. Draw Axis, Trends, Draw Pixel/Line), are cleared when SB 28 turns ON; the programmer may use the Negative Transition of SB 28 to refresh these elements on the LCD. |

| SB 29 HMI keypad entries complete, reload vars  
(Relevant for non touch-screen models: V120, V230, V260) | By program | By OS | Turn SB 29 ON after data is keyed into any variable, to enable the user to skip keying in data for the remaining variables in the current display.  
When SB 29 is ON:  
- No cursor blinks on screen.  
- The current values of all variables is loaded on screen. |

| SB 30 Current keypad entry sets SB 30 (HMI keypad entries complete)  
(Relevant for non touch-screen models: V120, V230, V260) | • By OS  
• By SB29 turning ON  
• By program | • When a Display is entered  
• By turning SB31 ON  
• When SB 27 and 29 turn OFF  
• When keypad entry variable is touched | Use SB 30 to run ladder tasks that require data entered via keypad.  
• When a variable is active, pressing the Enter button on the keypad signals that the user has finished entering the value. When the Enter button has been pressed for each variable in the current display, SB 30 turns ON.  
**Note** • To immediately re-enable data entry (restore cursor) turn SB 31 ON |

| SB 31 Refresh current LCD screen display variables  
(Relevant for non touch-screen models: V120, V230, V260) | By program | By OS | Restores the Display cursor, re-activates all keypad entry variables in the current Display. |

| SB 32 HMI keypad entry in progress | By OS | By OS | This turns ON automatically when the blinking cursor is on an active variable. |

SBs 33 and 34 function when an HMI Display that calls a subroutine is loaded/unloaded from the display screen.
### Note

ASCII String Display: In cases where a Display contains a Display ASCII String Variable, and the linked subroutine contains the Display String 'trigger' MB, reset this MB when the Display unloads by using the falling edge of SB 34.

<table>
<thead>
<tr>
<th>SB 33</th>
<th>Load Display with linked Call Subroutine</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>By OS</td>
</tr>
<tr>
<td></td>
<td>By OS</td>
</tr>
<tr>
<td></td>
<td>When a Display containing a Call Subroutine <strong>starts loading</strong>, SB 33 turns ON for a single scan cycle the first time the linked subroutine runs. Use this SB to initialize operands in the HMI subroutine.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SB 34</th>
<th>UnLoad Display with linked Call Subroutine</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>By OS</td>
</tr>
<tr>
<td></td>
<td>By OS</td>
</tr>
<tr>
<td></td>
<td>When a Display containing a Call Subroutine <strong>starts unloading</strong>, SB 34 turns ON for a single scan cycle the last time the linked subroutine runs.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SB 36</th>
<th>INFO mode</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>By OS, Remote Access, or program</td>
</tr>
<tr>
<td></td>
<td>Turns OFF when user exits Info Mode</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SB 37</th>
<th>Exclude last Display from FIFO</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>By Remote Access, or program</td>
</tr>
<tr>
<td></td>
<td>OS</td>
</tr>
<tr>
<td></td>
<td>Enables user to skip going back to certain Displays.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SB 38</th>
<th>Invert Touchscreen element pixels (Text, images)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>By program</td>
</tr>
<tr>
<td></td>
<td>By program</td>
</tr>
<tr>
<td></td>
<td>If a Touchscreen text or image element is touched and this bit is on, the pixels in the element reverse color.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SB 76</th>
<th>Keypad Entry: Focus (V130) (Press &quot;Enter&quot; 1x)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>By program</td>
</tr>
<tr>
<td></td>
<td>By program</td>
</tr>
<tr>
<td></td>
<td>If SB 76 is OFF after Keypad Entry, the user must use the arrow keys to move to the next variable. Turning SB 76 on causes the next variable set in Variable Tab Order to automatically become active. (can be used with SB108)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SB 108</th>
<th>Press &quot;Enter&quot; 1x (V130)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>By program</td>
</tr>
<tr>
<td></td>
<td>By program</td>
</tr>
</tbody>
</table>
|        | Normally, when a user enters a Keypad Entry value on a V130 HMI, the user must press the Enter button twice:
|        | - Once to 'approve' the value
|        | - Once to jump to and activate the next variable.
|        | You can control this by turning both SB 76 and SB 108 ON in your application. Note that the user can press ESC to exit keypad entry mode. |

<table>
<thead>
<tr>
<th>SB 110</th>
<th>Draw: Out of Range</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>The OS attempts to draw a line or pixel outside of the legal limits of the controller's LCD.</td>
</tr>
<tr>
<td></td>
<td>At the beginning of every cycle</td>
</tr>
<tr>
<td></td>
<td>OS</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SB 250</th>
<th>Keypad entry within limits (Standard Vision, Enhanced Vision variables use status operand)</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>By OS</td>
</tr>
<tr>
<td></td>
<td>By OS</td>
</tr>
<tr>
<td></td>
<td>- The current Display is either recalled or changed, or</td>
</tr>
<tr>
<td></td>
<td>- At the beginning of the next program cycle.</td>
</tr>
<tr>
<td></td>
<td>Turns ON for one scan when the entered value is within the Min/Max limits set in the variable's parameters.</td>
</tr>
</tbody>
</table>
### About the HMI Display and Keypad

#### HMI SB and SIs

<table>
<thead>
<tr>
<th>SB 251</th>
<th>Keypad entry exceeds limits (Standard Vision. Enhanced Vision variables use status operand)</th>
<th>By OS</th>
<th>By OS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- The current Display is either recalled or changed, or
- At the beginning of the next program cycle.

**Note:** When this SB is ON, the blinking cursor remains on the active variable even after the user presses Enter.

<table>
<thead>
<tr>
<th>SI 6</th>
<th>Current key pressed</th>
<th>LCD Contrast Control: 0=Minimal Contrast, 50=Medium Contrast, 100=Maximal Contrast</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SI 7</th>
<th>LCD Backlight intensity</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SI 9</th>
<th>LCD Backlight intensity</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SI 40</th>
<th>Touchscreen is being touched- X coordinates</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If the screen is touched, SI 40 shows the current location on the X axis.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SI 41</th>
<th>Touchscreen is being touched- Y coordinates</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>If the screen is touched, SI 41 shows the current location on the Y axis.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SI 50</th>
<th>INFO delay time - Default by O/S (every power up) = 4 seconds.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Units: seconds.</td>
</tr>
<tr>
<td></td>
<td>• Legal values: 0, 3 to 20.</td>
</tr>
<tr>
<td></td>
<td>• If you force or store '0' into equal Zero INFO is disabled.</td>
</tr>
<tr>
<td></td>
<td>• For V290 Touching the &lt;i&gt; key on the touch screen starts Info Mode Touching a legal Ladder application variable clears the INFO time.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SI 249</th>
<th>Last Active Keypad Entry Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Contains the ID number of the last active variable.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SI 250</th>
<th>Current active keypad entry, read/write.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>When either SB 250 'Keypad Entry Within Limits' or SB251 'Keypad Entry Exceeds Limits' turn ON, the index number of the variable is stored here. As you navigate between variables, as for example with the right-left arrow keys, SI 250 will show only the numbers of variables that have not been completed.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> A value of -1 indicates that, in this particular display, the user has pressed Enter for all the Keypad Entry variables in the Display.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SI 251</th>
<th>Previous HMI Display Number</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>To see a list of Displays in a project together with their Display numbers, select HMI Information from the View menu.</td>
</tr>
</tbody>
</table>

#### SDW

**# Description** Value | Comments
---|---
SDW 10 Keypad entry variable value | When a keypad entry variable value is entered, this SDW 10 holds the value.
SDW 30 Variable display bitmap, 0=Normal, 1=Inverse (or negative) | The value is checked when a display is entered.
| It is initialized to 0:  - At Power-up.  - When the program exits the Display. | When a bit is ON, the corresponding variable is displayed in inverted (negative) color; black pixels are changed to white and white to black.
SDW 31 Hide Var | The value is checked when a display is entered.
| It is initialized to 0 at:  - Power-up.  - When the program exits the Display. | When a bit is ON, the corresponding variable is hidden.
Images

Graphic Images in Displays
Simple geometric shapes can be drawn on a Display.
Graphic images can be imported from the Image Library, or created with a program such as Microsoft Paint and then imported.

- Fixed graphic images
  This type of image stays on the screen and does not change until a different Display is loaded by the program.

- Variable graphic images
  Variable images change according to the value of a linked operand.
  Binary Image Variables are linked to bit operand status (MB, SB, I, T, o). List Image Variables are linked to integers (MI, SI, ML, SL)

You can draw graphic images directly on a Display, or import images.

Notes
- Although an imported image can be resized, resizing may result in some degree of distortion. To avoid this, use images that are created to match the required size.

- The HMI display uses a grid which spaces the lines 8 pixels apart. To optimize Displays and shorten the PLC cycle time, images and variables should be aligned to grid.

Color Images
Color Vision supports .wmf, .emf, .bmp, .png, and .jpg.

However, to get the best results, follow these recommendations:

- Create images using a vector-based graphic design program.
- Set your PC Display color depth to 32-bit: right-click the desktop, select Properties>Settings, and under Color Quality select 32-bit.
- Create images of the correct size, so that they will not have to be resized within VisiLogic.
Use .wmf or .emf image formats. If these must be resized, they will give better results than .bmp, .jpg, or .png

Why images may distort when imported into VisiLogic and displayed on the controller's screen:

Resized images: jpg, png, and bmp are 'lossy', which means that quality is lost when the image is resized. If images must be resized, emf and wmf will give better results.

Color conversion: VisiLogic uses the basic pallet shown below. When an image contains additional colors, an algorithm performs color substitutions (interpolation. This means that the results may not reproduce the colors in the original image.

Selecting Quantization

Note that you can select between two algorithms, RGB and LAB. LAB generally gives better results, however note that the image conversion process may take longer.

1. From the HMI menu, click Quantization, and then select RGB or LAB.

To see the color pallet, select an object Properties from the HMI menus, and then click on one of the colors.
Images: Fixed
This type of image stays on the screen until a different Display is loaded by the program.

Once the image is on the display, you can open its properties by double-clicking it. Note that via Properties, you can resize the image and open it in Microsoft Paint for editing.

Variable Images
Variable images change according to the value of a linked integer.
Image Library

A library containing hundreds of images can be found in the Unitronics folder on your hard drive (Unitronics\VisiLogic\Data\Images).

This makes it easy to locate and import images into your displays.

**Note**
- An imported image cannot exceed the size of the controller's display screen listed in the model's technical specifications. For example, the V230's Display screen is 128x64 pixels, therefore an image of 100x100 pixels cannot be used unless it is resized in a third-party utility such as Paint.

- Clicking any HMI image in a Display will open the Image Library; to open the image for editing in Paint, click the Paint icon on the lower left side of the Library frame.

For tips on how to edit images to best suit the controller's Display screen, first read the Help Topic Creating Images with Microsoft Paint, and then view the demo located on the VisiLogic setup CD: **Edit Image Collections with Paint Step 1.exe**.
Drawing Shapes on a Display

VisiLogic's Shape toolbar enables you to draw lines, rectangles, rounded rectangles, and ellipses. Color Vision series also include Frame and Button. The Display Grid can aid in sizing and aligning images directly on a Display.

1. Select a shape.

2. Click on the display to anchor your cursor, and drag the shape by dragging the cursor across the screen.

You can edit an object's properties.
You can also resize a shape by clicking it, then dragging the image handles.

**Draw Static Axis**

This HMI utility enables you to place background axes for graphs.

1. Click on Create Static Axis, then click on the Display.
2. Create Static Axis opens, drawing the axis and showing the default settings.
3. Edit the default settings, if desired, then click OK.

The default settings may be edited; you can also select whether to place a frame around the Draw area.
Lock Display

Locking a Display prevents you from moving display elements accidentally. When the Display is locked, you can continue adding new elements. In a Locked display, the elements are marked with red; unlocked displays are marked by green.

System Images

You can customize your application by replacing system images, such as the Unitronics’ Splash Screen, and the Unitronics’ icon that appears in Information mode, with your own custom images.

1. On the Project menu, click System images.
2. Click on the desired image, click on Replace Image, and navigate to your custom image.

Notes

You can restore default System Images by clicking on the appropriate
You can replace the virtual keypad images; however note that the touch locations for the keys will not be changed from the default.

### Display Variable Types

#### Variable Types

Note that some of the variables listed below and shown in the next picture are dependent on controller type.

<table>
<thead>
<tr>
<th>Text Variable</th>
<th>Image Variable</th>
<th>Numeric Variable</th>
<th>Clock Variable</th>
<th>Timer /Counter Variable</th>
<th>SD</th>
</tr>
</thead>
<tbody>
<tr>
<td>Binary (bit)</td>
<td>Binary Image</td>
<td>Number</td>
<td>Real Time Clock</td>
<td>Timer</td>
<td>SD Browser</td>
</tr>
<tr>
<td>Text</td>
<td>List of Texts: by Pointer</td>
<td>Password</td>
<td></td>
<td>Counter</td>
<td></td>
</tr>
<tr>
<td>List of Texts: by Pointer</td>
<td>List of Images: by Pointer</td>
<td>Bar/Shape Graph</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>List of Texts: by Range</td>
<td>List of Images: by Range</td>
<td>Trend Graph</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### ASCII String

- Display RTC (ASCII)
Bit (Binary) Text Variable

This type of variable displays a different text message on the controller's LCD screen according to the status of a bit operand.

Inserting and Defining the Variable

1. Click on the variable in the Variable toolbar, then click on the HMI screen and drag your cursor to create a field for the display of the variable data.
2. Release the mouse button; a dialog box opens, enabling you to define the source of the variable data.
3. Link a bit operand, and enter text for both bit states.
Color Vision series also offer a Switch property. Selecting Switch assigns an MB and built in Touch property to a binary variable. Touching the variable toggles the image or text displayed.

**Bit (Binary) Image Variable**
This type of variable displays a different image on the controller's LCD screen according to the status of a bit operand.

1. Click on the variable in the Variable toolbar, then click on the HMI screen and drag your cursor to create a field for the display of the variable data.
2. Release the mouse button; a dialog box opens, enabling you to define the source of the variable data.
3. Link a bit operand, and select images for both bit states.

Selecting Switch assigns an MB and built in Touch property to a binary Text or Image variable. Touching the variable toggles the image or text displayed.
About the HMI Display and Keypad Display Variable Types

**Numeric (Number) Variable**

A Number Variable enables you to:

- Show any numeric value within a Display.
- Control the format in which that value is shown, including the placement of a decimal point and leading zeros.
- Use **Linearization** to show a converted value, such as an analog temperature converted to degrees Celsius.
- Allow the operator to use the controller keypad to enter a number, such as a setpoint, via a **Keypad Entry Variable**.

**Inserting and Defining the Variable**

1. Click on the variable in the Variable toolbar, then click on the HMI screen and drag your cursor to create a field for the display of the variable data.
2. Release the mouse button; a dialog box opens, enabling you to define the source of the variable data.
3. Select from the features and formats shown below. Note that this image shows the options for a Standard Vision.

   To see how to use Keypad Entry Variables, refer to the Indirect Clock example.

**Touchscreen-only models (V290, V530)**

These models have a 'virtual' keyboard. After a keypad entry variable is touched on the screen, the keyboard is automatically displayed, enabling the value to be entered. Note that you can set a font for variable display in Font Handler.
When an HMI keypad entry variable is active, and the Enter key is pressed on the controller keypad, SB 30 HMI Keypad Entries Completed turns ON. This can be used as a Jump condition.

- SB 250, Keypad Entry within Limits, turns ON when a legal value is entered; SB 251, Keypad entry exceeds limits, turns ON when a value is out of range. You can use the status of these bits, for example, to provide a jump condition to another Display. When either of these SBs turns ON, the index number of the active variable is stored in SI 249. Note that you can limit the number of attempts by using SI 45 Numeric Key Entry Out of Limit - Counter of Attempts (Enhanced) to jump to another Display.

SI 253 the user can change the password (or view it when the controller is Online)

**Standard and Enhanced Vision Divisions**

Note that there are a number of differences between Vision Divisions.

<table>
<thead>
<tr>
<th>Keypad Entry Variables</th>
<th>Standard Vision</th>
<th>Enhanced Vision</th>
</tr>
</thead>
<tbody>
<tr>
<td>SB 92 Keypad Entry in Progress (ON during entry) (Enhanced Vision)</td>
<td>SB 92 Keypad Entry in Progress (ON during entry) (Enhanced Vision)</td>
<td>SB 92 Keypad Entry in Progress (ON during entry) (Enhanced Vision)</td>
</tr>
<tr>
<td>SB 93 Keypad Entry Var Activates (ON for 1 scan) (Enhanced Vision)</td>
<td>SB 93 Keypad Entry Var Activates (ON for 1 scan) (Enhanced Vision)</td>
<td>SB 93 Keypad Entry Var Activates (ON for 1 scan) (Enhanced Vision)</td>
</tr>
<tr>
<td>SB 94 Keypad Entry Var Complete (ON for 1 scan) (Enhanced Vision)</td>
<td>SB 94 Keypad Entry Var Complete (ON for 1 scan) (Enhanced Vision)</td>
<td>SB 94 Keypad Entry Var Complete (ON for 1 scan) (Enhanced Vision)</td>
</tr>
<tr>
<td>SB 250 HMI key entry within limits (Standard Vision only)</td>
<td>SB 250 HMI key entry within limits (Standard Vision only)</td>
<td>SI 45 Numeric Key Entry Out of Limit - Counter of Attempts (Enhanced Vision) (Counts the number of failed attempts to enter a value)</td>
</tr>
<tr>
<td>SB 251 Keypad entry exceeds limits (Standard Vision only)</td>
<td>SB 251 Keypad entry exceeds limits (Standard Vision only)</td>
<td>If a Legal Entry bit is defined, SB 94 does not turn ON if the entered value is out of range. The keypad stays on screen until a legal value is entered.</td>
</tr>
<tr>
<td>SI 249 Last Active Keypad Entry Var (Standard Vision only)</td>
<td>SI 249 Last Active Keypad Entry Var (Standard Vision only)</td>
<td>SI 249 Last Active Keypad Entry Var (Standard Vision only)</td>
</tr>
</tbody>
</table>
About the HMI Display and Keypad

**Standard and Enhanced Vision Divisions**

<table>
<thead>
<tr>
<th>SI 250</th>
<th>Currently active keypad entry (read/write) (Standard Vision only) SDW 10 Keypad entry variable value</th>
</tr>
</thead>
<tbody>
<tr>
<td>You can use SI 45 in conjunction with a Compare function to exit the variable.</td>
<td></td>
</tr>
</tbody>
</table>

**Active Keypad Entry (SBs)**

| SB 32 HMI Keypad Entry in Progress (Standard Vision) rises during keypad entry |
| SB 92 HMI Keypad Entry in Progress (Enhanced Vision) rises during keypad entry |

**Keypad Entry: Focus**

| After Keypad Entry, the next variable set in Variable Tab Order automatically becomes active. |
| If SB 76 is OFF after Keypad Entry, the user must use the arrow keys to move to the next variable. Turning SB 76 on causes the next variable set in Variable Tab Order to automatically become active. |

**Password Entry via HMI**

- Correct password turns SB250 ON
- Wrong Password turns SB251 ON

Legal Entry bit in Password Variable turns ON when correct password is entered.

**Entering a legal keypad entry value**

| SB 250 Keypad entry Within Limits turns ON for 1 scan |
| SB 94 Keypad Entry Var Complete + Keypad entry property: Legal Entry MB |

- Turns ON when entered value is within legal limits
- Turns OFF when entered value exceeds legal limits

**Entering an illegal keypad entry value**

- SI 250 Last Active Keypad Variable contains the number of that variable
- SI 251 Currently Active Keypad Entry contains the number of that variable. The application can change the operand value to force a variable into active state
- SI 250 Last Active Keypad Variable and SI 251 Currently Active Keypad Entry contains the number of the relevant DLU.

**Active Keypad Entry Variables (SIs)**

| Enhanced Vision (V130 only) Turned ON by user |
| Turn ON to lock all keypad entry variables. |

**Keypad Vars Locked**

| Enter Display with locked Keypad Entry Variables |
| Same |

| Enter ASCII value |
| Currently Active Keypad Entry |
How Keypad Entry Variables Work
Keypad Entry Variables enable a user to enter values via the Vision keypad. In order to enable the user to enter values, the variable must be active.
When a variable is active, pressing Enter 'locks' the variable, and writes whatever value has been entered from the keypad into the variable. The next variable becomes active.

Keypad Entry Variable 'Tab' Order
Variable Tab Order enables you to determine the order in which Keypad Entry Variables will be activated, regardless of their location on the LCD screen.

Note: If Variable Tab order is not set, when the application is downloaded the variables will be activated in the order in which they were created. This may create the false impression that the variables are being activated 'randomly'.

Clicking the Variable Tab Order button displays all of the keypad entry variables in a Display.

When a Display contains more than 1 variable, using the right arrow key enables the user to tab from one active variable to the next. Pressing Enter 'locks' the variable, excluding it from the tab order.

Displays containing Keypad Entry Variables
A Display with Keypad Entry Variables may be in one of two states:

- **Active**
  The variables are active, marked by a blinking cursor. A Display loads into this state by default; the first variable, as set in Variable Tab Order, will be active.

System Status
About the HMI Display and Keypad Standard and Enhanced Vision Divisions

<table>
<thead>
<tr>
<th>#</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>SB 30</td>
<td>HMI keypad entries completed</td>
<td>OFF</td>
</tr>
<tr>
<td>SB 32</td>
<td>HMI keypad entry in progress</td>
<td>ON</td>
</tr>
<tr>
<td>SI 250</td>
<td>Currently active keypad entry</td>
<td>-1</td>
</tr>
</tbody>
</table>

- **Locked**
  - When variables are locked, no cursor is present on the LCD.

**System Status**

<table>
<thead>
<tr>
<th>#</th>
<th>Description</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>SB 30</td>
<td>HMI keypad entries completed</td>
<td>ON</td>
</tr>
<tr>
<td>SB 32</td>
<td>HMI keypad entry in progress</td>
<td>OFF</td>
</tr>
<tr>
<td>SI 250</td>
<td>Currently active keypad entry</td>
<td>-1</td>
</tr>
</tbody>
</table>

You can load all Displays in a project in the locked state via SB 27, Disable all keypad automation. If SB 27 is ON when a Display is shown, the user cannot navigate through the variable using the keypad keys and no cursor is present on-screen. V280 users may, in order to enable variables to be activated only through 'touch', turn SB 27 ON as a power-up task.

**Note**

When V290 is selected in Hardware Configuration, SB 27 is ON by default. When SB 27 is ON, no cursor is present on-screen. This enables the V290 user to activate any Keypad Entry Variable by touching it.

You can also load a specific Display with all variables locked via SB 30, by building a net as shown below. Note that SB 30 should not be used to lock variables after a Display has been loaded.

After a Display loads, you can enable the user to **skip** keying in data for all of the variables on-screen, by turning SB 29 ON after data is keyed into any variable. When a specific Display is on-screen, turning SB 29 ON, locks all of the remaining variables.

**Notes**

Regardless of the variable tab order, the user can activate variables by:

- **Touch**, if the project is based on a touch-screen controller and if the touch property has been assigned to the variable. If this property is assigned, touching the variable activates it, causing it to be marked by the blinking cursor.
- **By writing the variable ID # into SI 250**, either via Ladder program, Information or Online mode. These methods can also activate 'locked' variables, in which values have already been entered, or that have been locked via SBs 27.
Relevant HMI SBs and SIs

To see the variable ID numbers, open HMI Information from the View menu and click the Variables tab.

Touchscreen models (V290/V280)

There are 2 types of Vision touch-screen models:

- Models which comprise only a virtual keypad (V290). In these models, the virtual keypad opens whenever the user touches a keypad entry variable that is currently displayed on the screen.

- Models which comprise both an HMI function keypad and a virtual keypad (V280). However, in these models, the virtual keypad must be activated by turning SB 22 Enable Virtual Keypad ON (Note: SB22 is relevant only to Standard Vision + Touchscreen, not Enhanced) This must be done at
power-up, or before the Display containing the keypad variable is entered. In addition, the Keypad entry variable must be assigned a Touch Property. After a keypad entry variable is touched on the screen, the keyboard is automatically displayed, enabling the value to be entered. Note that you can set a font for variable display in Font Handler.

In addition, the Keypad entry variable must be assigned a Touch Property.

After a keypad entry variable is touched on the screen, the keyboard is automatically displayed, enabling the value to be entered. Note that you can set a font for variable display in Font Handler.

![HMI Display and Keypad Standard and Enhanced Vision Divisions](image)

**About the HMI Display and Keypad Standard and Enhanced Vision Divisions**

**VisiLogic: HMI Applications**

When an HMI keypad entry variable is active, and the Enter key is pressed on the controller keypad, SB 30 HMI Keypad Entries Completed turns ON. This can be used as a Jump condition.

**SB 250, Keypad Entry within Limits, turns ON when a legal value is entered; SB 251, Keypad entry exceeds limits, turns ON when a value is out of range. You can use the status of these bits, for example, to provide a jump condition to another Display. When either of these SBs turns ON, the index number of the active variable is stored in SI 249.**

**System Bits, non touch-screen and touch-screen Vision PLCs**

Certain SBs are only relevant to certain controller models, those with touch screens and those without. Note that the V280 contains both touch-screen and keypad.

**Which variable is active? Models with keypads**

In these controllers, a blinking cursor marks the active keypad entry variable. This cursor indicates that the user can begin to enter a value via keypad. The user navigates through the variables by using the directional arrows on the keypad.

Note that the V280 keyboard is enabled by default. The
information here is relevant when keypad entry variables are **not** assigned touch properties.

### Controlling the cursor via SBs

<table>
<thead>
<tr>
<th>SB 30 HMI keypad entries complete</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use SB 30 to run ladder tasks that require data entered via keypad.</td>
</tr>
<tr>
<td>Note that when a variable is active, pressing the Enter button on the keypad signals that the user has finished entering the value.</td>
</tr>
<tr>
<td><strong>After</strong> the Enter button has been pressed for all of the variables in the current display, SB 30 turns ON.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SB 31 Refresh current LCD screen display variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use SB 31 to immediately re-enable data entry.</td>
</tr>
<tr>
<td>Turning SB 31 ON restores the cursor, and re-activates all keypad entry variables in the current display.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>SB 29 Current keypad entry sets SB 30</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turn SB 29 ON after data is keyed into any variable, to enable the user to skip keying in data for the remaining variables in the current display.</td>
</tr>
<tr>
<td>After SB 29 turns ON, SB 30 turns ON as well.</td>
</tr>
</tbody>
</table>
SB 76 Keypad Entry: Focus (V130 only)
If SB 76 is OFF after Keypad Entry, the user must use the arrow keys to move to the next variable. Turning SB 76 on causes the next variable set in Variable Tab Order to automatically become active.

Touch-screen only (V290)
The V290 does not have a physical keypad. When V290 is selected in Hardware Configuration, keypad entry variables must be assigned a Touch property. Then, when a keypad entry variable is touched, a virtual keypad is displayed on screen. Note that in a display that contains keypad entry variables, the variables are not marked by a blinking cursor. The programmer must include a clue to inform the user as to what part of the screen must be touched.
In V290, SB 22 Enable Virtual Keypad, and SB 27 Enter Display without active Keypad Entry Variables are ON by default.
**Touch-screen and keypad** (V280)
The V280 has both a physical keypad and a virtual keypad.

**Physical Keypad mode**
If you include keypad entry variables in your displays, by default, the V280 functions like other Vision models with physical keypads. A cursor indicates keypad entry variables, and the user enters data via the physical keypad.

**Physical Keypad mode + Touch**
If you give Touch properties to keypad entry variables, a cursor still indicates active variables; however, you can page through these variables by touching them on the screen. The user enters data via the physical keypad.

**Physical Keypad mode + Touch + 'No Cursor'**
You can cancel the blinking cursor by turning SB 27 ON. This also means that the user can only page through the keypad entry variables by touching them. Pressing the physical keypad arrows will not page through the variables.

**Virtual Keypad (V290) mode**
Turn SB 22 ON. When this is done, the V280 will function just like the V290 described in the section above.

**Clock Variables**
Place Clock Variables in Displays to show times and dates. In addition to showing RTC values, use Clock Variables in conjunction with Indirect time functions to enable an operator to set times via the controller keypad.

A keypad-enabled Clock Variable accepts a number entered via the controller keyboard, and stores the number in the operand linked to the Variable.

**Inserting and Defining a Keypad Entry Clock Variable**
1. Click on the variable in the Variable toolbar, then click on the HMI screen and drag your cursor to create a field for the display of the variable data.
2. Release the mouse button; a dialog box opens, enabling you to define the source of the variable data.
3. Check Keypad Entry and select the format and display font.
About the HMI Display and Keypad  

Clock Variable: View/Enter RTC:UTC Values

The Real-Time-Clock value in the controller can be shown in a Display.

Inserting and Defining the Variable

- Create a Variable field and select **Real Time Clock**, then define the Variable by selecting the time format and display font. You do not link an operand because this variable is already linked to the RTC.

**Note** Only full format variables, hh.mm.ss can be set as keypad entry.

**UTC Variables**

Placing a UTC variable displays the value of the linked operands as an RTC value.

**Note** Step-by-step instructions on how to use Keypad Entry Clock Variable values are provided in the Indirect Clock function example.
Note that if you select to display SI 30, the variable will display the full RTC value.

**Keypad Entry**

On the screen, the variable is shown in Time format, according to your selection.

- **DW**
  The 32-bit binary number contains the UTC value in **seconds**, where 1900-01-01 = 00:00.00 UTC.

- **SI**
  To set the RTC from the HMI, link the UTC variable to SI 30; the value entered via keypad is written to RTC system operands SI 30-34.

- **MI**
  Linking an MI causes the UTC value entered via keypad to be written to a vector of 4 MIs, where the selected MI is the start of the vector.

**List of Texts: by Pointer**

This type of Variable contains numbered lines of text. You link the Variable to an operand. The value within that operand 'points' to the number of a line within the list. When the operand value is equal to a particular line number, the text of that line is shown in the Display.

**Inserting and Defining the Variable**

1. Create a Variable field, and then select **List of Texts: by Pointer**.
2. Define the Variable by entering lines of text and linking an operand.
Note • By using the Keypad Entry Option, you can also enable the user to select a line using the Up/Down keypad arrows.

• The Keypad Entry option is not supported for Touchscreen-only models (V290).

List of Images: by Pointer

This type of Variable contains a list of numbered images. You link the Variable to an operand. The value within that operand 'points' to the number of an image within the list. When the operand value is equal to a particular image's number, that image is shown in the Display.

Note • By using the Keypad Entry Option, you can also enable the user to select a line using the Up/Down keypad arrows.

• The Keypad Entry option is not supported for Touchscreen-only models (V290).
Inserting and Defining the Variable

1. Create a Variable field, and then select **List of Images: by Pointer**.
2. Define the Variable by adding images to the List of Images and linking an operand.

**List of Images: by Range**

This type of Variable contains a list of images. You define a range of values for each image and link the Variable to an operand. The value within this operand is compared to the range you have defined for each image. When the operand value falls within a specified range, the image assigned to that range is shown in the Display.

Note that you can define the beginning and end of a range using either a Constant value or an MI.
Inserting and Defining the Variable

1. Create a Variable field, and then select **Range of Images: by Pointer**.
2. For each line: define the beginning of the range, the end of the range, and assign an image.

Graphs: Displaying Values

Bar and Shape graphs can be used to show how values progress. You can use them together with other Display elements to help operators track system progress and status.

This is a sample of an HMI Display and how its elements can look on the controller’s LCD.
Inserting the Graph

1. On the HMI toolbar, click on a **Graph** icon; then drag the cursor across the controller screen to create the graph object.
2. Select the appropriate options. Graph options vary according to the Vision Division and HMI Display type.

Defining the Graph


Bar graph

---

**Note**

Vision controllers also support Trend graphs
About the HMI Display and Keypad

Shape graph

Enhanced Vision
Bar graph
### About the HMI Display and Keypad

#### Standard and Enhanced Vision Divisions

---

**VisiLogic: HMI Applications**

---

![Image of a variable bargraph window](image)

**Parameter** | **Type** | **Function**
---|---|---
Direction | Selection option | Select the direction in which the bar will grow
Min/Max | Constant or register | Sets Limits
Fill Color | Selection option | Click to open Color palette and select a color for the bar

**Meter graph**

Click the tabs to configure the appearance of the Meter.

![Image of a variable meter window](image)

**Tab** | **Function**
---|---

---

**VisiLogic: HMI Applications**

---
## About the HMI Display and Keypad

**Standard and Enhanced Vision Divisions**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arc</td>
<td>Click and drag the slides to adjust the Radius, Arc Angle, and Rotation</td>
<td></td>
</tr>
<tr>
<td>Needle</td>
<td>Adjust the appearance of the needle</td>
<td></td>
</tr>
<tr>
<td>Ticks</td>
<td>Adjust Tick length and thickness</td>
<td></td>
</tr>
<tr>
<td>Label And Background</td>
<td>Edit the Meter name, and select a background color or image</td>
<td></td>
</tr>
<tr>
<td>Ranges</td>
<td>Assign colors to different sections of the Meter's Arc</td>
<td></td>
</tr>
</tbody>
</table>

### Tank graph

![Tank graph](image)

### Table

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Type</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tanks</td>
<td>Selection option</td>
<td>Select the tank type</td>
</tr>
<tr>
<td>Min/Max</td>
<td>Constant or register</td>
<td>Sets Limits</td>
</tr>
<tr>
<td>Fill Color</td>
<td>Selection option</td>
<td>Click to open Color pallet and select a color for the tank</td>
</tr>
</tbody>
</table>

If the background color is displaying incorrectly, note that a tank object should not be placed on a white background. In this case, certain tank objects might be partially framed in yellow frame. Any other color may be used. In addition, note that changing the background color of the display does not change the background color of the .emf tank graphic.

**V290 color, V570**

### Trends

**LEDs**

The bars in a LED graph represent a changing value in the same way that the lights of a stereo equalizer represent the sounds. You configure the number and color of the LEDs in the graph.
### About the HMI Display and Keypad Standard and Enhanced Vision Divisions

#### Parameter | Value
---|---
Number of LEDs | Maximum number = 32.
Min/Max | Depends whether the link is to a single or double register; for example MI range is 32768 to +3276; ML range is -2,147,483,648 to +2,147,483,647.
LEDs Preview | Use the slider to check the appearance of the graph.
Fore Color | Click to edit the color surrounding the LEDs.
Direction | Changes the orientation of the graph.
From | Assigns the number of LEDs to the value range. For example, the following image shows that the low range assigned to Green is 0-30; there are 3 bars assigned to that range.
The minimum width of a LED bar is 2 pixels, and that the space between bars is 2 pixels. If the height of the graph is not evenly divided by the number of pixels used by the bars and spaces, the remaining pixels will be colored as the Fore Color.

Thermometer

Represents a value by changing the level of a thermometer icon.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Min/Max</td>
<td>Depends whether the link is to a single or double register; for example MI range is 32768 to +3276; ML range is -2,147,483,648 to +2,147,483,647.</td>
</tr>
<tr>
<td>Ticks</td>
<td>Change number and color.</td>
</tr>
</tbody>
</table>
Trends

A Trend graph displays a dynamically changing value graph that tracks a single, dynamic value such as a temperature value, as a curve on the Vision screen.

**Note**

Trends (Legacy) Function Block

If your project is configured to Standard Vision controllers that do not support HMI object Trend graphs, the Trend objects will not be displayed in the Project Navigation Window. In these models, use the Trends (Legacy) Function Block.

Trends are displayed in the Project Navigation Window. The number of Trends and Curves that can be displayed depends on controller model:

- **V570/V350**
  - Up to 8 Trends, each displaying up to 8 Curves
- **V130**
  - Up to 4 Trends, each displaying up to 2 Curves

Each Curve may be linked to a different register, and can be configured to a different color.

Trends have a default touch property that causes a touched Curve to be brought forward. In the following figure, the Temperature curve is in front.

Touch the Mode button to toggle between:

- **Run Mode:** Shows the Trend being drawn in real-time
- **History Mode:** Stops the Trend, displays History Scroll buttons; touch these to scroll back and forth between different Trend graph sections
V130

Since the V130 does not offer a touch screen, you use the Keypad arrow buttons to enter and navigate through History Mode

Enter History Mode | Up arrow
Exit to Online Mode | Down arrow
Scroll through History | Left and right arrows

Creating a Trend graph
1. Define a Trend:
   Right-click the desired Trend to open and set Trend Properties.
**About the HMI Display and Keypad Standard and Enhanced Vision Divisions**

**Property** | **Function**
--- | ---
Name | Assign a unique name to the Trend.
Sampling Interval | Defines how often the Trend draws Curves, resolution = deciseconds (0.1.)
History Samples | Total number of samples that may be stored in History for ALL Trends is 32000. The minimum number that may be allocated to a Trend is 50. To view the total History Allocation, right-click Trends in the Project Navigation Window.

**Run / Stop MB**

0 = Stop
1 = Run
Status rises from 0 to 1:
- The PLC begins to draw the Trend Curves
- The History is initialized
- 'Run' is displayed at the bottom of the graph
Falls 1 to 0
- Trend freezes
- Under can press Mode button to enter History and scroll through Trend
- 'Stop' is displayed at the bottom of the graph

2. Define Curves
Right-click the desired Curve to open and set Curve Properties.

**Property** | **Function**
--- | ---
Name | Assign a unique name to the Curve for display on the HMI screen.
You can also use the String Library. The string you
select will be displayed as the Curve name on the HMI screen; however, note that the string you select will not appear on the Project Navigation tree.

<table>
<thead>
<tr>
<th>Data Operand</th>
<th>This is the value represented by the Curve</th>
</tr>
</thead>
<tbody>
<tr>
<td>Y Min, Y Max</td>
<td>These define the axis range for that Curve. Note that you can also set a decimal value.</td>
</tr>
</tbody>
</table>

Once you configure a Trend and at least a single Curve, you can place the graph in different HMI displays and set specific properties for the Trend in that display, such as the Trend background color and Curve colors.

3. Place a Trend Graph in an HMI Display
a. Click the Trend icon on the HMI toolbar, and then drag the cursor across the screen to draw the Trend.

b. Release the mouse button, and define the Trend Variable properties.

**Note**
Under Links, note that the Link MI shows which Curve is currently forward

- V570 1= Curve 1, 2=Curve 2, etc. Therefore when the MI contains 3, Curve number 3 will be forward
- V130:2=Curve 2. 1, or any other value causes Curve 1 to be forward
<table>
<thead>
<tr>
<th>Tab</th>
<th>Property</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appearance</td>
<td>Points to Display</td>
<td>Sets the number of actual points that will be shown on the screen at any one time</td>
</tr>
<tr>
<td></td>
<td>Number of X ticks, Y ticks</td>
<td>Set the number of gradations on the axes</td>
</tr>
<tr>
<td></td>
<td>History scroll mode</td>
<td>Sets the paging size for History view</td>
</tr>
<tr>
<td></td>
<td>Draw lines between points</td>
<td>If this is not selected, the Curves will be drawn as a series of points</td>
</tr>
<tr>
<td></td>
<td>X Axis Color</td>
<td>Note that the Y Axis color always changes to match the Curve than is in front</td>
</tr>
<tr>
<td></td>
<td>Buttons Color</td>
<td>Sets the color for the Mode, Grid, and History Scroll buttons</td>
</tr>
<tr>
<td></td>
<td>Grid Color</td>
<td>Set the color for the background Grid</td>
</tr>
<tr>
<td></td>
<td>Change current Curve on Touch</td>
<td>Checked by default. Curves have a built-in touch property that causes the touched Curve to be brought forward.</td>
</tr>
<tr>
<td>Curves</td>
<td>Color</td>
<td>Click to set a color</td>
</tr>
<tr>
<td></td>
<td>Hide Curve</td>
<td>if you assign a Hide Curve MB, turn it ON to hide the Curve.</td>
</tr>
</tbody>
</table>

Note that the Link MI determines which curve is forward. In the case of the V570, touching the curve writes the curve value to the MI, bringing the touched curve forward.
**Trend from SD**

Note that you can also display a Trend Curve from the Trend History that is stored on an SD Card. The parameters are the same as in Variable: Trend, given above.

![Variable: Trend from SD](image)

4. Control the Trend by toggling on the Run/Stop MB assigned in the Start and stop the Trend as shown below.

![Control Trend MB](image)

To learn more about Trends, check Trends - Color Vision.vlp in the Help> Examples.

<table>
<thead>
<tr>
<th>#</th>
<th>Description</th>
<th>Value</th>
<th>Comments</th>
</tr>
</thead>
</table>
| SI 63 | Maximum number of Trend files that can be saved (read-only) | 0-64        | • Initialized at Power-up.  
• Updated when:  
  - when SB 217 is ON  
  - when Trend file is created.  

The value in SI 63 shows the number of remaining *.utr files; if 5 *utr files exist, SI 63 = 59.  

---

**SD Card Browser**

Placing this variable on screen enables a user to press a button to display all of the files in the specified folder.

- **Touch Screens (V570/V350):** The user presses the Browse SD on-screen button. If file selection is enabled, the user touches files names to select them.
- **Non-Touch Screens (V130):** The user presses the Enter button, and navigates between files using the arrow keys.

SD Ladder Functions enable you to read/write data between an SD Card and PLC memory operands, including blocks of file data, Data Tables, and Trend data.

You can also enable the user to delete files, or to copy the file name to an operand vector. You can control whether to display the Delete button by using the Hide Delete File MB.

**Note** The SD Card Browser only displays file types that are relevant for the
requested folder. For example, when you view DT files, you will only be able to see .udt and .fdt files; if there are other files in the folder they will not be displayed.

In the Web folder, all file types are displayed. Note that in VisiLogic versions earlier than 8.0.46, EXCEL folders cannot display .txt files. In addition, PLCs running an OS earlier than 3.0.59 do not support .txt display.

Moving Image
This type of variable displays a moving image on the controller's LCD screen; the image moves according to the value of the linked MI. This feature is only supported by the Standard Vision Division.
Note that all of the moving images in the above picture are linked to MI 1. When MI 1 holds 0, the images are at the start of their 'containers'. When MI 1 increments to 1000, the images are at the end of their 'containers'. The 'containers' set the size of the field in which the image can move. The range of movement for the field is 0 - 1000--no matter how long the field is.

**List of Texts: by Range**

This type of Variable contains lines. You define a range and enter text for each line, and link the Variable to an operand. The value within this operand is compared to the ranges you have defined for each line. When the operand
value falls within a specified range, the text assigned to that range is shown in the Display.

Note that you can define the beginning and end of a range using either a Constant value, or an MI.

Inserting and Defining the Variable
1. Create a Variable field, and then select **Range of Texts: by Pointer**.
2. For each line: define the beginning of the range, the end of the range, and assign text.
3. Use the **Add Line button** and **Delete Line button** as needed.

String Library
Use String Library to store text strings within the controller's FLASH memory, and then display them on the controller's LCD. You can, for example, organize text into different String Libraries—for example, separate libraries for Spanish,
English and Italian—pull strings into HMI objects, and then switch libraries to change the display language.

These strings can be displayed in the following HMI elements:

- Frame
- Button
- Fixed Text

String Libraries also provide the text for Alarms, and can be used in Trend Curve Properties.

There are:

- 16 String Libraries containing up to 1024 strings each. You can change the library default names.
  Via String Library> File, you can opt to use only 4 or 8 libraries; in this case the total number per library is 2,046 strings.
  Note that each library contains sections in the 3,000 range, that are ‘greyed’; these are reserved for system use.
- Each string can contain up to 128 characters.

The total memory capacity for all String Libraries is 64K.

This feature is not available in Standard Vision controllers.

**How String Library works**

Only one library is active at a time. This means that at any given time, all elements that pull text from a library are using the same library.

However, each HMI element may be linked to a different line ID # within that String Library.

In the following figure, the buttons are linked to different text lines. Each time a different String Library is called, the button text changes.

**Configuring Strings**

1. Click the String icon on the navigation tree or toolbar to open the Strings editor.
2. Click on File> Rename Library to assign a unique name to the Library

3. Double-click on a row to open the String Editor. Note that the String Editor opens strings according to the ID #. In the following figure, the first three messages are displayed for String Libraries Letters_1, Numbers_2, and Symbols_3.
3. Place your cursor in the desired String Library row, and type in text. You can also include indirect text from an MI vector. The text is displayed in the PLC Preview window.

You can also break text lines by including Carriage Return + Line Feed characters.
Note that you can find Unreferenced Strings via the binoculars icon on the String Library toolbar.

**Importing/Exporting Strings to/from Excel or .csv**

These tools are located on the String Library File menu.

- **Excel:** you cannot create an Excel file and import it. You must export a String Library from a String Library, delete any undesired information, and then enter your own strings.

- **.csv:** you must use a delimiter that does not appear within the string’s data, or the values will not be separated according to expectations.

**Import/Export from Excel**
1. Select all of the Strings in a Library. and then select Export
2. From the File menu, select Export to Excel.

3. Open and edit the Library, and then import it into any Library.

**Linking HMI Elements to Text in a String Library**

1. Place a Frame, Button, or Fixed Text HMI element. Within the element properties, click the String from String Library option. You can either link a Text ID line directly, or use an MI to indirectly provide the Text line ID.

   Note that the size of the HMI element must be large enough for the longest text line it may hold.
Switching Libraries
To switch Libraries, use one of these methods:

- Use the Ladder function Strings>Set String Library
- Write a value to SI 491 Switch current Text Library

ASCII String
You can display a vector of MI, ML, or DW values as an ASCII string. The value of each byte in the vector is displayed as an ASCII character. You can also enable a user to enter characters directly into the variable by pressing keys on the Vision keypad. ASCII String is located on the Text Variable menu.
The Display String 'trigger' MB is set and reset by the user. Note that the OS refreshes the string and resets the MB when the MB turns ON. If the MB is continuously set by the application, the change in status will not occur and the string will not be refreshed.

**Note**
- String Pattern defines the size of the text field. The default string 'Text To Display' will provide a field long enough to contain most strings.
- SBs 33 and 34 function when an HMI Display that calls a subroutine is loaded/unloaded from the display screen. In cases where a Display contains a Variable:ASCII String, and the linked subroutine contains the Display String 'trigger' MB, you can reset this MB when the Display unloads by using the falling edge of SB 34.

To create a field that contains enough bytes to provide for the width of the ASCII characters in a variable string, enter a line of text in String Pattern that contains characters of the necessary width.
The character 'W' is generally the widest character in a font set.

A vector is read **either** until the end of the defined vector length, or until a 'null' character is encountered. By adding a **null character** to the end of the stream, you can mark the end of a data string. This can prevent other data, that might be present in a vector, from being added to the data string when the vector is read.

### Entering ASCII via Keypad

When you select Keypad Entry, the user can enter upper and lower case characters as well as symbols.

**Vision: Standard Keypad**

- **To select the character 'a', press key quickly 3 times.**
- **To select the character '2', press key quickly 4 times.**
- **Press < for lower case.**
- **Press the symbol key twice to display symbols.**
- **Use arrows to move between symbols, < > to select symbol.**
- **Press < > to confirm entered text.**

<table>
<thead>
<tr>
<th>ASCII value</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>45</td>
<td>54</td>
<td>54</td>
<td>54</td>
<td>54</td>
<td>20</td>
<td>20</td>
<td>4F</td>
</tr>
<tr>
<td>TEXT TO DISPLAY</td>
<td>49</td>
<td>44</td>
<td>44</td>
<td>50</td>
<td>52</td>
<td>41</td>
<td>4C</td>
<td>4F</td>
</tr>
</tbody>
</table>

**Note:**
About the HMI Display and Keypad

About the HMI Display and Keypad

Vision: Color Touchscreen models

When the user touches the screen, the virtual keypad opens. Use the top arrows to page between keypads to enter capital letters, lower-case, and symbols.

Vision: Monochrome Touchscreen models

There are 2 types:

- Models which comprise both an HMI function keypad and a virtual keypad (V280).
Note

Models which comprise only a virtual keypad (V290).

In models which comprise only a virtual keypad (V290), the virtual keypad opens whenever the user touches a keypad entry variable that is currently displayed on the screen.

However, in models which comprise both an HMI function keypad and a virtual keypad (V280), the virtual keypad must be activated by turning SB 22 Enable Virtual Keypad ON. This must be done at power-up, or before the Display containing the keypad variable is entered.

In addition, the Keypad entry variable must be assigned a Touch Property.

Strings: Display RTC (ASCII)

You can display an RTC value as an ASCII string by using the RTC to ASCII function together with the ASCII String variable.

To use Display RTC:

1. Select RTC to ASCII from the String menu on the Ladder toolbar.
2. Place the function in the net, and select a display format; both European and American format are available.
3. In the HMI Display, select Display RTC from the Text Variable menu.

When the program shown below is downloaded, pressing key 1 on the Vision's keypad will display the current time on the Vision's LCD.
Password: Keypad Entry

You can insert a Password Variable that requires operators to enter a password via the controller's keyboard.

Note that Passwords are handled differently in Standard and Enhanced Vision Divisions, as described below.

Standard Vision

Note • SB 250, Keypad Entry within Limits, turns ON when a password is correctly entered; SB 251, Keypad entry exceeds limits, turns ON when a password is incorrect. You can use the status of these bits, for example, to provide a jump condition to another Display. When either of these SBs turns ON, the index number of the active variable is stored in SI 249.

1. Select **Password** from the Numeric menu, and drag your cursor across the screen to create the Password field.

2. Click Link to assign either a Constant value or DW. Note that selecting DW also enables you to set the number of asterisks shown in the Password field.
Note • Standard Vision division: When an HMI keypad entry variable is active, and the Enter key is pressed on the controller keypad, SB 30 Variables Locked turns ON. This can be used as a Jump condition.

Enhanced Vision

The Password field is a touch-screen button. When the user touches it, the virtual keypad appears, enabling the user to enter the password.

1. Select **Password** from the Numeric menu, and drag your cursor across the screen to create the Password button.
2. Assign Display text to be shown within the button. If you leave this blank, asterisks will be shown in the button by default.
3. Click Link to assign either a Constant value or DW.
4. Assign an MB to Legal Entry; this MB will turn ON when the correct password is entered. You can use this to jump to another Display.
Note that you can limit the number of attempts by using SI 45 Numeric Key Entry Out of Limit - Counter of Attempts (Enhanced) to jump to another Display.

SI253 the user can change the password (or view it when the controller is On-Line)

Timers: Displaying Values
A Timer Variable shows a timer's value in a Display.

1. Create a Variable field, and then select Timer.
2. Select from the features and formats shown below.
About the HMI Display and Keypad

Display/Preset Counter Values
A Counter Variable shows a counter's value in a Display.
1. Create a Variable field, and then select **Counter**.
2. Select from the features and formats shown below.

'Touch' Property (Touchscreen models only)
When a touchscreen controller, such as the V280, is selected in Hardware Configuration, you can assign Touch properties to any screen element. With the exception of keypad entry variables, Touch elements are linked to MBs.
1. Select any screen element, then click the Assign Touch Property button; the Select Operand box opens, enabling you to link an MB.

When this element is touched, the linked MB will turn ON, when the element is not touched, the MB will be OFF.

An MB that is linked to a 'Touch' element cannot be linked to any other element on the Display. The MB may be linked to 'Touch' elements in different Displays.

To edit the MB that is already linked to the Touch element, select the element and then click the Assign "Touch" Property icon; the Select Operand box opens.

Note: An MB that is linked to a 'Touch' element cannot be linked to any other element on the Display. The MB may be linked to 'Touch' elements in different Displays.

Text

Fonts

Fonts are used in text boxes and to display Variable data.

Note: Fonts are not standardized. For example, two different PCs may both contain a font called Arial. Displays created on one PC using that font may look different or distorted when opened on the other PC. This can be fixed by opening the application and replacing the font; you may replace the font with a font of the same name to solve this problem.

Font Handler

Font Handler enables you to define the fonts and character sets you use to write text in Displays.

Use Font Handler to:

- Add fonts. Note that VisiLogic is supplied with a single default font.
- Define fonts, including size, style, and effect.
- Delete unused fonts, and unused characters. This can dramatically decrease the font memory requirements.
- Select foreign or special characters, such as degree signs.

**Using Font Handler**

Open Font Handler by clicking the  icon on the toolbar, clicking it in Text Properties, or by selecting it from the HMI menu.

International characters are supported via the Script box, which displays all Windows fonts installed on your PC.

**Note**

Color Vision models, such as V570, use default system fonts. These fonts (which are highlighted in grey) contain a limited character set, and cannot be modified.

To add a font that contains additional / multilingual characters, click on the Add New Font button..
Note • Any characters within a font that are too big to be displayed on the controller's LCD will be marked in red.

If you are using an Enhanced Vision with a touch screen, you can select the keyboard that Vision displays for Keyboard Entry variables.
Text: Fixed

Fixed (constant) text does not change according to run-time conditions.

To place fixed text messages in a Display:

1. Click the Text Box icon; your cursor turns into a crosshairs.
2. Click in the Display to anchor the cursor, then drag the cursor across the screen; when you release the mouse button, the Text properties box opens.
3. Click here to enter text.

Use the Font Handler to add fonts and determine font sizes.

String Library

Use String Library to store text strings within the controller’s FLASH memory, and then display them on the controller’s LCD. You can, for example, organize text into different String Libraries—for example, separate libraries for Spanish, English and Italian—pull strings into HMI objects, and then switch libraries to change the display language.

These strings can be displayed in the following HMI elements:

- Frame
- Button
Fixed Text
String Libraries also provide the text for Alarms, and can be used in Trend Curve Properties.

There are:

- 16 String Libraries containing up to 1024 strings each. You can change the library default names.
  Via String Library> File, you can opt to use only 4 or 8 libraries; in this case the total number per library is 2,046 strings.
  Note that each library contains sections in the 3,000 range, that are 'greyed'; these are reserved for system use.
- Each string can contain up to 128 characters.

The total memory capacity for all String Libraries is 64K.

This feature is not available in Standard Vision controllers.

How String Library works
Only one library is active at a time. This means that at any given time, all elements that pull text from a library are using the same library.

However, each HMI element may be linked to a different line ID # within that String Library.

In the following figure, the buttons are linked to different text lines. Each time a different String Library is called, the button text changes.

Configuring Strings
1. Click the String icon on the navigation tree or toolbar to open the Strings editor.
2. Click on File > Rename Library to assign a unique name to the Library.

3. Double-click on a row to open the String Editor. Note that the String Editor opens strings according to the ID #. In the following figure, the first three messages are displayed for String Libraries Letters_1, Numbers_2, and Symbols_3.
3. Place your cursor in the desired String Library row, and type in text. You can also include indirect text from an MI vector. The text is displayed in the PLC Preview window.

You can also break text lines by including Carriage Return + Line Feed characters.
Note that you can find Unreferenced Strings via the binoculars icon on the String Library toolbar.

**Importing/Exporting Strings to/from Excel or .csv**

These tools are located on the String Library File menu.

- **Excel**: you cannot create an Excel file and import it. You must export a String Library from a String Library, delete any undesired information, and then enter your own strings.
- **.csv**: you must use a delimiter that does not appear within the string’s data, or the values will not be separated according to expectations.

**Import/Export from Excel**

1. Select all of the Strings in a Library, and then select Export
2. From the File menu, select Export to Excel.

3. Open and edit the Library, and then import it into any Library.

**Linking HMI Elements to Text in a String Library**

1. Place a Frame, Button, or Fixed Text HMI element. Within the element properties, click the String from String Library option. You can either link a Text ID line directly, or use an MI to indirectly provide the Text line ID.

   Note that the size of the HMI element must be large enough for the longest text line it may hold.
Switching Libraries
To switch Libraries, use one of these methods:

- Use the Ladder function Strings>Set String Library
- Write a value to SI 491 Switch current Text Library
Index

A
Add
  Add font.......................... 88
Align ................................ 16
ASCII String.................... 73, 79, 83, 91
B
bank................................. 17
Bar graph.......................... 58
Binary Variables............... 41, 42, 43
C
Clock................................. 53
Controller.......................... 3
Controller keyboard............. 53, 84
Copy & Paste........................ 6
Counter Values................... 87
Cut & Paste.......................... 6
D
Data, entry via keypad .......... 11
Dates ................................ 53
Display text messages......... 11, 83
Displaying Values 11, 47, 58, 79, 83, 87
Displays 3, 4, 6, 7, 8, 11, 13, 14, 15, 16, 17, 19, 23, 24, 26, 28, 37, 40, 41, 47, 54, 71, 79, 87, 88, 91
Distorted.......................... 88
E
Edit ................................ 47
Edit values ....................... 47
editing, keyboard................. 47
Enter data via keypad. 11, 44, 47, 84
password........................... 11, 84
F
Fixed text ......................... 4, 91
Fonts................................ 88
  Font Handler..................... 88
Function.......................... 53
G
Gage................................ 58
Gauge................................ 58
global............................... 17
Global HMI Variable Bank...... 17
Graphics .. 4, 16, 33, 36, 37, 40, 58, 71
Graphs ................................ 11, 39, 58
H
HMI.... 3, 4, 7, 8, 13, 14, 15, 16, 17, 19, 20, 24, 26, 28, 33, 36, 40, 41, 47, 58, 71, 73, 79, 87, 91
  HMI keypad entries completed... 28
I
Image... 3, 4, 11, 33, 36, 37, 40, 41, 43, 55, 56, 57, 71
  Image Variable............... 36, 58, 71
Import/Export..................... 7
Indirect Clock function......... 53
Information Mode................ 14
Insert.............................. 13, 15, 36
J
Jumps................................ 8, 19
K
Keypad ................................ 14, 47
Keypad Entry .......... 11, 14, 47, 54, 84
Keypad Entry Clock Variable ..47, 53, 54
Keypad Entry Variable...... 44, 47, 54
L
List................................. 55, 56, 57, 72
Load Display...................... 8, 19
Load Functions................... 24
M
Meter................................ 58
N
Number Variable.................. 44
Numeric........................... 41
P
Password........................... 84
Pictures............................ 4, 33, 37, 71
Program Flow...................... 23
Program Sequence................ 23
R
Range............................ 57, 72
Resizing......................... 26
RTC Real-Time-Clock ....... 53, 54, 83
S
SB-System Bit..................... 28
SD................................ 70
Setpoint......................... 44
SI-System Integer............... 23, 28
Size................................ 26
String............................ 79, 83
Subroutines...................... 20
System Operands............... 28
T
Text..... 4, 41, 42, 55, 72, 73, 88, 91
Text Variable................... 73, 83, 91
Time................................ 54
Timers............................ 4, 41, 86

VisiLogic: HMI Applications 96
Index

Touch ............................................. 79
Touch-screen .................................. 14, 79
Troubleshooting ............................ 47

U
Undo ................................................... 8
UTC ...................................................... 54
utility .............................................. 40

V
Variable text ................................... 4
Variable Types ............................... 41, 58, 70, 83, 87
Variables ........................................ 3, 4, 11, 13, 15, 17, 33, 37,
41, 42, 43, 47, 54, 55, 56, 57, 58,
72, 84, 87
Virtual keypad .................................. 79

www.klinkmann.com

Helsinki
tel. +358 9 540 4940
automation@klinkmann.fi

Yekaterinburg
tel. +7 343 376 5393
yekaterinburg@klinkmann.spb.ru

Samara
tel. +7 846 273 95 85
samara@klinkmann.spb.ru

Kiev
tel. +38 044 495 33 40
klinkmann@klinkmann.kiev.ua

Riga
tel. +371 6738 1617
klinkmann@klinkmann.lv

Vilnius
tel. +370 5 215 1646
post@klinkmann.lt

Tallinn
tel. +372 668 4500
klinkmann.est@klinkmann.ee

Moscow
tel. +7 495 641 1616
moscow@klinkmann.spb.ru

Мinsk
tel. +375 17 200 0876
minsk@klinkmann.com

St. Petersburg
tel. +7 812 327 3752
klinkmann@klinkmann.spb.ru